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1

COMPACT PROJECTS

The documentation about the Compact project type is organized into the following 
sections:

Installation and Project Fundamentals
The following sections provide general information about installations and 
InstallShield 11.5 Express Edition projects.

What Is an Installation?
An installation, in its simplest terms, is the “package” used to install your files and 
programs onto your end user’s machine. It is a complete collection of the application 
files, as well as logic that interacts with the installer service. The primary task of any 
installation is to transfer the application files from the installation disk to the end 
user’s computer. The complexities of the Windows operating system make it anything 

Table 1-1: Sections in the Documentation for Compact Projects

Section Description

Installation and 
Project 
Fundamentals

Contains introductory information about InstallShield 11.5 Express Edition and 
installation projects.

Creating 
Installations

Describes the main tasks involved in working with InstallShield 11.5 Express 
Edition projects.

Reference Contains comprehensive reference information for the InstallShield 11.5 
Express Edition user interface; errors and warnings that might occur when you 
build your installation; and sample end-user dialogs.
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but simple to create an effective, coherent installation without the aid of a utility such 
as InstallShield 11.5 Express Edition.

Overview of Installations
Even if you are unsure what an installation is, you have probably used one before. If 
you have ever installed a product onto your computer, you have seen an installation in 
action, from the end user’s perspective. The installation transfers files from the source 
medium to your local drive. It also makes the required registry entries, and creates 
shortcuts. Installations commonly gather information about the target machine and the 
user.

Typical Elements of an Installation

Perform File Transfer
File transfer involves copying files from the source medium, such as a CD or a floppy 
disk, to a local drive on the end user’s machine. Depending on the configuration the 
end user chooses, all or only some of the files may be transferred to the local disk. 
During file transfer, a status bar may be displayed to show the progress of the file 
transfer process.

Display User Interface
The user interface of an installation provides information and installation 
configuration choices to the end user. Through the user interface, an end user can 
choose to install only part of a product, view a license agreement, or provide 
information to the installer that may be necessary to ensure the proper configuration of 
the installation.

Create Shortcuts
Shortcuts are links to files and applications that can be created on the end user’s 
machine during an installation. Shortcuts are often placed on the desktop or the Start 
menu of the target machine to provide quick and easy access to a program or its files.

Register Product for Uninstallation
In order to uninstall a product, the operating system must know that the product is 
present. Therefore, an installation registers a product with the operating system so that 
it can be easily uninstalled. Much of the information registered in this process is 
available to the end user through Add or Remove Programs in the Control Panel. For 
example, technical support contact information, product update information, product 
version, and product publisher information are all registered in this process.
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InstallShield 11.5 Express Edition Projects
When you create your installation, you also create an InstallShield project file, which 
has an .ise file extension. This file stores all the logic and information necessary to 
build the Setup.exe installation file, which you can distribute to your end users. 
When you exit InstallShield, the project file is automatically saved.

All new projects are saved in the following default location:

C:\My InstallShield Express Projects

This default location appears in the Save As dialog box.

Project Types
A Compact project uses a special compact installer engine to provide the user 
interface for an installation. When you choose this project type, you need to create 
features and specify all application files and other distributable data.

Although Compact installation projects have some limitations—for example, English 
is the only language available for the end user interface—they enable you to create a 
very small executable file (Setup.exe) that you can distribute to end users. This 
Setup.exe file is a compressed, self-extracting file that contains all of the application 
files, as well as the Compact installer engine.

Limitations of Compact Projects
Installations that are built with the Compact project type in InstallShield automatically 
include a special installer—the Compact Installer. The Compact project type lets you 
quickly create a Setup.exe installation file that is very small and suitable for Web 
downloads.

The Compact project type is ideal if you need to create a small installation composed 
of files, registry settings, and shortcuts. If you want your project to have any of the 
following functionality, you should switch to a Windows Installer–based or 
InstallScript-based project type:
• Include redistributables (merge modules and objects).
• Scan the files in your project for any dependencies that they require, and add the 

detected dependencies to your project.
• Include an ODBC resource.
• Make .ini file changes.
• Make .xml file changes.
• Set environment variables on the target system.
• Manage IIS on a target system.



Chapter 1: Compact Projects
Installation and Project Fundamentals

4 InstallShield Express Edition Compact Project User Guide

• Add a COM+ application to your project.
• Add mobile device support to your project.
• Include custom actions.
• Create an upgrade or a patch to update an earlier version of the application.
• Include support files (that is, files that are needed during the installation but are 

removed before the installation ends).
• Display billboards during the run time of the installation.
• Enable your installation to be updated via the Update Service.
• Search for installed data on the target machine at run time.

In addition, English is the only language available for the end-user interface of a 
Compact installation.

Note that you cannot create a patch or an upgrade for an application that was packaged 
with the Compact project type. In addition, the Compact Installer does not let end 
users reinstall the same application to the same location on the target machine without 
first removing the application through Add or Remove Programs in the Control Panel. 
End users do have the ability to install an already installed application to a different 
location and remove the earlier installation through Add or Remove Programs.

Creating New Projects
There are a number of ways to create a new InstallShield project.

TASK To create a new project, do one of the following:

• Click the New Project button on the toolbar.
• On the Start Page, in the Project Tasks section, click Create a new project.
• Press CTRL+N.
• On the File menu, click New.

Any of these steps opens the New Project dialog box, where you can specify the file 
name for the project that you want to create. Once you entered the necessary project 
information in the New Project dialog box and clicked OK, the Project Assistant is 
opens to help you create your project.
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Opening an Existing Project

TASK To open an installation project by using the Open Project button or the Open command:

1. On the toolbar, click the Open Project button, or on the File menu, click Open. 
The Open dialog box opens.

2. Select the project that you would like to open.
3. Click the Open button.

TASK To open a project by using the Start Page:

1. Click the Start Page tab.
2. In the Project Tasks section, click Open an existing project. The Open dialog 

box opens.
3. Select the project that you would like to open.
4. Click the Open button.

Using the Project Assistant
When you create a new installation project, the Project Assistant is automatically 
activated. The Welcome page contains an Installation Design Diagram to help you 
visualize the steps involved in creating an installation. Work within the Project 
Assistant to create your project.

Navigating in the Project Assistant

TASK To navigate from one page of the Project Assistant to another, do one of the following:

• To navigate directly to a specific page, click the appropriate icon in the navigation 
bar at the bottom of the page.

• To follow the Project Assistant steps sequentially, do one of the following:
» Click the Next or Back arrow buttons to move forward or backward.
» Press CTRL+TAB to move to the next panel and CTRL+SHIFT+TAB to 

move to the previous panel.
• To move back to the Home page and view the Installation Design Diagram, click 

the Home button on the navigation bar.
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Using the Section Links
The left area of each page contains up to two sections of links, when applicable, to 
assist you in creating your installation and finding information:
• More Options—Provides additional configuration options relating to the specific 

area on the Project Assistant page. These are less common options that complete 
the functionality of the Project Assistant.

• Help Links—This list provides links to help topics pertinent to the current Project 
Assistant page.

Saving an Installation Project
To save an installation project, do one of the following:
• On the toolbar, click the Save button.
• On the File menu, click Save.
• Close your installation project. InstallShield notifies you if any unsaved changes 

have been made and asks if you want to save them now.

Since you specified a file name and location when you first created your installation, 
you will not be prompted for that information again.

TIP If you want to save a copy of your installation project, on the File menu, click Save As, and 
specify a new file name for your project.

Changing the Default Project Location

TASK To specify a new default location for your installation projects:

1. On the Tools menu, click Options. The Options dialog box opens.
2. Click the File Locations tab.
3. In the Project Location box, type a new path or click Browse to find the new 

location.
4. Click OK.

Creating Installations
If you have ever installed an application onto your computer, you have seen an 
installation in action—from the end user’s perspective. An installation’s primary task 
is to transfer files from the source medium to the local drive. An installation often also 
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displays a user interface to obtain end-user selections and configures the target system 
(for example, makes any required registry entries and creates shortcuts). Creating an 
installation involves performing some or all of the following tasks.

Specifying General Application Information
The Application Information page is where you specify general information about the 
application your project will install, including the application’s name and version, and 
your company’s name and Web address.

The More Options section on this page lets you set additional properties such as the 
product GUID, your company’s support Web address, and your company’s support 
telephone number. You can also modify the default installation folder for your 
application.

The initial value for the default installation folder is as follows:

[ProgramFilesFolder]<Company Name>\[Product Name]

This setting serves as the default folder for all of your application’s files. It is 
important to note that when you are setting this installation folder, you are specifying 
a default value. An end user could override this value during installation by selecting a 
new destination folder in the Choose Destination Location dialog.

Add or Remove Programs in Control Panel
Add or Remove Programs in Control Panel provides a list of the applications that are 
installed on a computer system. End users can view information about the applications 
installed on a machine and add, modify, or remove programs from Add or Remove 
Programs.

Add or Remove Programs on Windows 2000, Me, and XP platforms differs from that 
on earlier Windows operating systems in many ways. Depending on how an 
installation is configured, the end user has the option of removing, repairing, or 
changing the installation with the click of a button.

In Add or Remove Programs with Windows 2000, Me, or XP, users are also able to 
access additional information that is not available with earlier platforms. With this 
information, it is easier for your end users to find technical support links and phone 
numbers, product update information, and information about your company.

The information you provide on the Application Information page of the Project 
Assistant is used to populate information about your application for Add or Remove 
Programs when your application is installed.
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Company Name and Product Name in Your Installation
Your company name and product name are used in several places in your installation 
project.

Your company name is used to set the default installation directory for your 
application. It is also used in Add or Remove Programs in the Control Panel for your 
application on the end user’s system.

Your product name is used in your application’s entry in Add or Remove Programs in 
the Control Panel (in the support information link) on the target system. It is also used 
in setting the default installation directory.

Editing the Default Installation Location

TASK To edit the default installation location:

1. Open the Application Information page of the Project Assistant.
2. In the More Options section, click Edit the default installation location. The 

Set INSTALLDIR dialog box opens.
3. In the Destination Directories box, select the directory that should be used as the 

default installation folder. If you would like to create a new folder, select a 
directory or Destination Computer, and press INSERT. A directory is created 
beneath the selected item.

4. Click OK.

Specifying Support Contact Information
You can specify your company’s support Web address and phone number if you 
would like this information to be displayed for your application on the Support Info 
dialog box of Add or Remove Programs in Control Panel.

TASK To set the support Web address and phone number for your application:

1. Open the Application Information page of the Project Assistant.
2. In the More Options section, click Set Additional Properties. The Additional 

Properties dialog box opens.
3. In the Specify your company’s support web address box, type the URL that you 

would like your users to visit for technical support.
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4. In the Specify your company’s support telephone number box, type the 
technical support phone number that your users can call to get help with your 
product.

5. Click OK.

Changing Your Application’s Product GUID
Your application’s product GUID is a string GUID that uniquely identifies this 
product release. Since the product GUID uniquely identifies this release, changing the 
product code after you have already distributed your release is not recommended. The 
product code GUID should be uniquely generated for each version of your product.

TASK To change your application’s product GUID:

1. Open the Application Information page of the Project Assistant.
2. In the More Options section, click Set Additional Properties. The Additional 

Properties dialog box opens.
3. Click Generate New Product GUID. A unique GUID is generated.
4. Click OK.

Specifying Operating System Requirements for 
Your Application

The Installation Requirements page enables you to easily set installation requirements 
for the target system. For example, if your application requires a specific operating 
system in order to run properly, you can indicate that on this page. You can also 
specify the error message text that the installation should display for the end user if the 
operating system requirements are not met.

When you specify operating system requirements on the Installation Requirements 
page, InstallShield creates launch conditions.

How InstallShield Creates the Operating System Launch 
Conditions
When you specify operating system requirements on the Installation Requirements 
page, you are essentially excluding operating systems that do not support your 
application.

For example, if you select only the check box for the latest Windows operating 
system, InstallShield creates a launch condition to exclude the operating systems that 
you did not select on the Installation Requirements page. With this type of launch 
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condition, future versions of Windows operating systems are supported automatically 
because they are not excluded in the launch condition.

If you select each of Windows 9x check boxes, the launch condition that InstallShield 
creates excludes all Windows NT operating systems. In this scenario, any future 
Windows NT operating systems are not supported, but all future Windows 9x 
operating systems are supported.

NOTE You may need to install a different version of a feature depending on the operating system of the 
target system. For more information, see Specifying Feature Properties.

When Does the Installation Check for Requirements?
To ensure that the required operating system is present on the target system, 
InstallShield checks for these requirements in the beginning of the installation before 
any files are transferred.

Specifying the Features for Your Application
The Installation Architecture page lets you specify the features that you want your 
installation program to display to the end user. A feature is the smallest separately 
installable piece of your product from the end user’s standpoint. If you have more than 
one feature in your installation, the Feature Selection dialog is displayed during 
installation, enabling end users to select which feature or features should be installed.

NOTE Features can contain subfeatures, subsubfeatures, and so forth, to as many levels as your 
installation program requires.

Adding a Feature

TASK To add a feature:

1. Open the Installation Architecture page of the Project Assistant.
2. Select Yes to indicate that you want to customize your installation architecture.
3. To add a main feature, click the Installation Architecture node. To add a 

subfeature, click the feature that you want to be the parent feature.
4. Click New. The Project Assistant creates a new feature.
5. Name the feature or click Rename to name it later.
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TIP To set whether a feature is listed in the Select Features end-user dialog, and to specify the 
description associated with a feature, see Specifying the Features for Your Application.

Specifying Feature Properties
The Installation Architecture page enables you to set several properties that determine 
if and how a feature or subfeature is listed in the Select Features end user dialog. It 
also lets you set any operating system requirements for a feature or subfeature.

NOTE You cannot create conditions for the Always Install feature.

TASK To specify the properties of a feature or subfeature:

1. Open the Installation Architecture page of the Project Assistant.
2. Add the new feature if you have not already done so.
3. Select the feature whose properties you want to set.
4. Click Properties. The Properties dialog box opens.
5. On the General tab, set the properties that determine if and how the feature is 

listed in the Select Features end-user dialog.
6. On the Operating System tab, set any operating system requirements for the 

feature.

Determining Whether to Create a Multiple-Feature 
Installation

Features are the building blocks of an installation, from the end user’s perspective. 
Because of this, features should represent distinct and discrete pieces of functionality 
within your installation.

If your application has different blocks of functionality, you should create a multiple-
feature installation. For example, if your installation contains your application (.exe 
file) and a help library (.hlp file), your installation project should contain at least two 
features—one for each piece of functionality.

To learn more about creating a multiple-feature installation within the Project 
Assistant, see Creating Installations with Multiple Features.
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Creating Installations with Multiple Features
You can use the Project Assistant to create an installation with multiple features.

TASK To create a multiple-feature installation in the Project Assistant:

1. Open the Installation Architecture page of the Project Assistant.
2. Select Yes to indicate that you want to customize your installation architecture.
3. Right-click Installation Architecture and click New. A new feature is created.
4. Press F2 or right-click the feature and click Rename to provide a name for the 

new feature.

To create a subfeature, right-click the feature that you want to be the parent feature 
and create a new feature under the parent feature.

Default Features
All resources (for example, files or registry data) that are added to an installation 
project need to be associated with a feature. If a resource is not associated with a 
feature, it is not installed to the target system at run time.

Using a default feature simplifies the authoring experience in the Project Assistant. 
You do not need to worry about associating project resources with a feature to ensure 
that they are installed. When you add registry data, create new shortcuts, or add files 
when All Application Data is selected, all of these resources are added to the default 
feature. This ensures that all of the project resources you add in the Project Assistant 
will be installed to the target system when an end user runs your installation.

Setting the Default Feature

TASK To specify which feature is the default:

1. Open the Installation Architecture page of the Project Assistant.
2. Select the feature that you would like to set as the default feature.
3. Select Set Default.

What Happens If There Are No Features or No Default 
Feature Is Selected?
When you open the Installation Architecture page or add data to the Application Files, 
Application Shortcuts, or Application Registry pages, InstallShield selects the Always 
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Install feature as the default feature. If there are no features, InstallShield creates one 
silently.

Defining Feature Hierarchy
Top-level features are the highest level in the feature hierarchy. Top-level features 
might include the application you want to install, a help library feature, and a sample 
projects feature.

Beneath the top-level features are subfeatures or child features. This is a feature that is 
dependent upon another feature for installation purposes. If the parent (or top-level) 
feature is not installed on the target system, the child feature is not installed.

Specifying Application Files for Your Installation
The Application Files page lets you specify the files that you want to associate with 
each of your features.

Adding a File to a Feature

TASK To add a file to a feature:

1. Open the Application Files page of the Project Assistant.
2. In the feature list at the top of the page, select the feature to which you want to add 

a file.
3. In the Destination Computer explorer, select the folder to which you want to add 

the file.
4. Click Add Files. The Open dialog box opens.
5. Browse to the file that you want to add.
6. Click Open.

Removing a File from a Feature

TASK To remove a file from a feature:

1. Open the Application Files page of the Project Assistant.
2. Click the file you want to remove and press DELETE.
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Overwriting Files on the Target Machine
When files are transferred during an installation, and a file in the installation already 
exists on the target machine, the installer compares the version, date, and language of 
the files to determine which version should remain. The installer also checks the 
Always Overwrite property of a file. The following rules are enforced by the installer 
service:

Adding Files to a Fixed Folder Location
If you know exactly where you want the installation to install your project files on the 
target system, you can hard-code a fixed folder destination.

TASK To add files to a fixed folder location:

1. Open the Installation Architecture page of the Project Assistant.
2. Right-click Destination Computer and select New Folder.
3. For the new folder’s name, type the drive on which the destination is located—for 

example:

C:

4. Further define the destination path by adding subfolders beneath the drive letter 
folder.

Table 1-2: File Overwrite Rules

Rule Description

Always 
Overwrite

If you indicate that a file should always be overwritten, the file—if it exists on 
the target system—is always overwritten, regardless of the file version, 
language, or date.

On the File Properties dialog box, select the Always Overwrite check box to 
specify that the file should always be overwritten.

Versioned files In all cases, the file with the highest version is maintained, even if the file 
already on the target machine has a higher version than the one being installed. 
Additionally, a file of any version is maintained over unversioned files.

File language All other things being equal, the file that is the same language as the installation 
is maintained over different language versions of the file. The only exception to 
this rule applies to multiple language files. Files with multiple languages are 
maintained over single language versions of a file.

Date If the modified date of a file already present on the target machine is later than 
the creation date of that file, the file is not overwritten. This rule protects user 
preference files from being wiped out during an upgrade or reinstallation.
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Viewing Additional Predefined Folders
The Application Files page displays the more commonly used predefined folders. You 
can view and hide predefined folders on this page.

TASK To display additional predefined folders:

Right-click Destination Computer, point to Show Predefined Folder, and click 
the folder that you want to be displayed.

TASK To hide a predefined folder:

Right-click Destination Computer, point to Show Predefined Folder, and click 
the folder that you want to be hidden.

Defining Your Application Shortcuts
The Application Shortcuts page lets you specify shortcuts for your application’s files 
on the target system’s desktop or Start menu. By default, this page displays a shortcut 
for each executable that you have included in your installation project. You can delete 
these and add shortcuts to other files that you have included in your installation 
project.

Modifying a Default Shortcut

TASK To modify a default shortcut:

1. Open the Application Shortcuts page of the Project Assistant.
2. Click the shortcut that you would like to modify.
3. Select the Create shortcut in Start Menu check box, the Create shortcut on 

Desktop check box, or both as appropriate.

Creating an Uninstallation Shortcut
You can create an uninstallation shortcut to make it easier for end users to uninstall 
your product from their systems. When an end user launches the shortcut, the 
unnistallation process automatically starts.
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TASK To create an uninstallation shortcut:

1. Open the Application Shortcuts page of the Project Assistant.
2. In the More Options section, click Create an uninstallation shortcut.

Updating the Registry
The registry is a database for your computer’s configuration information. Information 
included in a computer’s registry includes user profiles, hardware and software 
installed on the computer, and property settings.

How Do I Know What Registry Data My Application 
Requires?
The application developer should be able to provide registry information for you. 
Specifically, you will need to know if the application you are installing requires any 
user-specific (HKEY_CURRENT_USER) or machine-specific 
(HKEY_LOCAL_MACHINE) settings.

The developer can provide a .reg file that you add to your installation. InstallShield 
enables you to import .reg files into your installation project.

Handling Registry Entries for a Per-User Installation
Since the current user may not have sufficient privileges for modifying keys under 
HKEY_LOCAL_MACHINE under Windows NT, Windows 2000, and Windows XP, 
you may need to write the entries under HKEY_CURRENT_USER.

When you select HKEY_USER_SELECTABLE on the Application Registry page of 
the Project Assistant, the entries are created under the appropriate registry hive, 
according to the type of installation and the user’s access rights. In a per-user 
installation, meaning that the installation is being run by someone with user-level 
access privileges, these entries would be made under HKEY_CURRENT_USER. In a 
per-machine installation, meaning that ALLUSERS is not null and that the user is an 
administrator, the entries would be written under HKEY_LOCAL_MACHINE.

Specifying Registry Data
The Application Registry page lets you specify any registry data that your application 
requires.
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TASK To add registry data:

1. Open the Application Registry page of the Project Assistant.
2. Select Yes in answer to the question about configuring registry data.
3. Right-click the registry item to which you want to add the data, point to New, and 

click Key.
4. Name the key.
5. Right-click the key, point to New, and click one of the following: Default Value 

String Value, Binary Value, DWORD Value, Multi-String Value, or 
Expandable String Value, depending on the type of data you want to register.

TASK To specify or modify a registry value:

1. In the Destination computer’s registry data box, double-click the value that you 
would like to specify or modify. The Edit Data dialog box opens.

2. In the Value data box, edit the data and click OK.

Using Variable Data Types in Registry Data
InstallShield enables you to use variable data types or properties when creating 
registry data for your installation project

TASK To use INSTALLDIR (the default installation directory) as a variable in the registry:

1. Open the Application Registry page of the Project Assistant.
2. Select Yes to indicate that you want to configure the registry data that your 

application will install.
3. Right-click HKEY_CLASSES_ROOT, point to New, and click Key.
4. Name the key Installation Location.
5. Right-click the Installation Location key, point to New, and click String Value.
6. Name the string value My Installation Location.
7. In the Destination computer’s registry data box, double-click the My 

Installation Location value. The Edit Data dialog box opens.
8. In the Value Data box, type the following:

[INSTALLDIR]

At run time, the value of [INSTALLDIR] is replaced with the installation directory.
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Importing Registry Data from a .reg File

TASK To import registry data from a .reg file:

1. Open the Application Registry page of the Project Assistant.
2. In the More Options section, click Import a .reg file. The Import REG File 

Wizard opens.
3. Follow the directions in the Import REG File Wizard to add the registry data.

NOTE When you add registry data to a feature, it is installed on the target system as long as the 
associated feature is installed.

InstallShield can import .reg files created by exporting in Regedit only, or files that follow that 
exact format. Additionally, InstallShield does not support multiline registry values.

Creating an Application Path Registry Key
The application path registry key contains data that Windows uses as a private search 
path for the specified application’s .dll files. If you install an application’s .dll files 
into a directory other than the application’s directory, you should set the appropriate 
application path to include the .dll directory during installation. Application path 
information is stored in the registry under 
HKLM\Software\Microsoft\Windows\CurrentVersion\App Paths\AppName.exe.

TASK To create an application path registry key:

1. Open the Application Registry page of the Project Assistant.
2. In the More Options section, click Create an application path. The Create an 

Application Path dialog box opens.
3. Click the ellipsis button (...). The Browse for Shortcut Target dialog box opens.
4. Select the executable (.exe) file in your installation for which you want to create 

an application path.
5. Click Open. The directory for the .exe file is added to the list of directories.
6. Click Add. The Browse for Directory dialog box opens.
7. Select the directory that contains the .dll files.
8. Click OK.
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Specifying End-User Dialogs for Your Installation
The Installation Interview page lets you specify the dialogs that you want end users to 
see when your installation program runs. Based on your answers to the questions on 
this page, the Project Assistant adds the corresponding dialog to your installation 
project.

The questions that are displayed to help you specify dialogs for your installation are as 
follows:
• Do you want to display a License Agreement Dialog?—Select Yes and click the 

Browse button to select your license agreement file.
• Do you want to prompt users to enter their user information?—Select Yes to 

display a dialog requesting this information.
• Do you want your users to be prompted to modify the installation location of your 

application?—Select Yes to present a dialog that lets end users change the 
installation location. See Enabling End Users to Modify the Installation Location 
for more information.

• Do you want to give users the option to launch your application when the 
installation completes?—Select Yes and click the Browse button to select your 
application file. When this option is set to Yes, the final dialog in the installation 
presents a check box that end users can select to immediately launch your 
application upon clicking the Finish button.

• Do you want to give users the option to launch a readme file when the installation 
completes?—Select Yes and click the Browse button to select the Readme file in 
your installation.

Enabling End Users to Modify the Installation Location
If you want to provide end users with control over where your software is installed on 
their system, you can enable them to modify the installation location.

In an InstallShield-based installation, the property INSTALLDIR serves as the 
default installation directory. When you let users modify the installation location, the 
Choose Destination Location dialog is presented during the installation.

License Agreements
To install your application, end users must agree to abide by certain legal 
requirements. For example, most software vendors do not allow users to copy or 
distribute their software to others.

To ensure that the end user understands the legal requirements associated with 
installing your software, your installation can present an End-User License Agreement 
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(EULA) in the License Agreement dialog during run time. The EULA is a legal 
contract between you and the end user, with regard to the use of your software.

The License Agreement dialog displays your license agreement text, and it contains 
Yes and No options. If end users select the No option because they do not agree to 
accept the EULA, your software is not installed and the installation terminates.

TASK To add a License Agreement dialog to your project:

1. Open the Installation Interview page of the Project Assistant.
2. For the Do you want to display a License Agreement Dialog? question, select 

Yes.
3. Type the path to your license agreement file or click the Browse button to find the 

file. The file must be a rich text file (.rtf).

Building Your Installation
The Build Installation page is where you build your installation.

TASK To build your installation:

1. Select the Single Executable check box.
2. Click Build Installations.

The Output window opens with the Output tab visible; it displays information about 
the progress of the build. The build is finished when the Output tab displays the log 
file information.

Build Release Location
The disk image folders for your installation are built in the release location. The 
release location is a subfolder of your project’s location.

The release is built in the following folder:

Project Location\Project Name\Express\SingleImage\DiskImages\DISK1

For example, if the current project name is CoolProject, the release location might be:

C:\My InstallShield Express 
Projects\CoolProject\Express\SingleImage\DiskImages\DISK1
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Build Logs and Reports
Each time you build an installation, a log and build report are generated. The log 
contains the same information displayed in the Output window during the build 
process. The build report contains a concise summary of your build, as well as a 
listing of all features and files included in your build. Since both the log and report are 
generated and timestamped each time you build the installation, you can use these for 
manual verification of the contents of installations, as well as for your records.

After Completing the Project Assistant: Next Steps
After going through the Project Assistant pages and completing the fields, you have an 
installation project framework that you can use as a functional installation. This 
section provides information to help you complete your installation.

Autorun
Sometimes when you insert software CDs into your computer’s CD-ROM drive, a 
multimedia CD browser automatically launches, enabling you to easily install the 
software. This autorun functionality is accomplished using a text file (Autorun.inf) 
on the root level of the CD. Primarily, this file is used to launch either a CD Browser, 
such as those created with DemoShield, or an installation program.

Enabling Autorun for Your CD

TASK To enable your CD to autorun when it is inserted into the target system’s CD-ROM drive:

1. Create a text file called Autorun.inf and place it on the root level of your CD-
ROM.

2. In the Autorun.inf file, specify the name of the file to automatically launch on 
CD insertion. Use the following syntax:

[autorun]
open = filename

filename is the name of the file you are launching. For example, if you are 
including Setup.exe in your installation, enter Setup.exe in the place of 
filename.

Testing Your Installation
Before you release your installation to end users, it is a good idea to put it through a 
few rigorous test runs. You can run your installation directly from InstallShield. 
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Running the installation executes your installation exactly as it would on an end user’s 
machine. All files are transferred, registry entries are made, and the end-user interface 
is displayed.

TASK To run your installation from within InstallShield, do one of the following:

• Click the Run button on the toolbar.
• On the Build menu, click Run SingleImage.

TIP Although you can run your installation from within InstallShield, it is also a good idea to test your 
installation on several clean machines before you release it.

Distributing Your Installation
When your installation is built and tested, the only task left is to distribute it. You can 
post it on the Internet or an intranet, copy it to a network, or copy it to a CD or other 
media type.

Reference
Reference information for InstallShield is organized into the following categories:
• Menus and Toolbar
• Start Page
• Project Assistant
• Output Window
• Import REG File Wizard
• Dialog Boxes
• End-User Dialogs
• Errors and Warnings

Menus and Toolbar
Below are comprehensive listings of all InstallShield menu commands, keyboard 
shortcuts for the commands, and corresponding toolbar buttons.

Each of the menus in InstallShield is described in this section:
• File Menu
• Edit Menu
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• View Menu
• Go Menu
• Build Menu
• Tools Menu
• Help Menu

File Menu
Below is a listing of the File menu commands, as well as associated keyboard 
shortcuts and icons.

Edit Menu
Below is a listing of the File menu commands, as well as associated keyboard 
shortcuts and icons.

Table 1-3: File Menu Commands

Command Shortcut Toolbar Button Description

New Ctrl + N Creates a new installation project.

Open Ctrl + O Opens an existing installation project.

Close Closes the current project.

Save Ctrl + S Saves the current project file.

Save As Saves the current project file under a 
different name.

1, 2, 3, 4 Opens one of the most recently 
accessed projects.

Exit Closes the current project and closes 
InstallShield.

Table 1-4: Edit Menu Commands

Command Shortcut Toolbar Button Description

Undo Ctrl + Z Undoes the last action performed.

Cut Ctrl + X Cuts the currently selected text to the 
clipboard.

Copy Ctrl + C Copies the currently selected text to the 
clipboard.
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View Menu
Below is a listing of the View menu commands.

Go Menu
Below is a listing of the Go menu commands, as well as associated keyboard shortcuts 
and icons.

Paste Ctrl + V Pastes the clipboard contents.

Table 1-5: View Menu Commands

Command Description

Output Window Toggles the display of the Output window.

Header Bar Toggles the header bar.

Toolbar Toggles the toolbar.

Status Bar Toggles the status bar.

Table 1-6: Go Menu Commands

Command Shortcut Toolbar Button Description

Previous View Alt + Up Arrow Takes you to the view that is listed 
directly above the current view on the 
Go menu.

Next View Alt + Down 
Arrow

Takes you to the view that is listed 
directly below the current view on the Go 
menu.

Back Alt + Left Arrow Takes you to the view that you last 
visited in the history of your view 
selections. You can use this multiple 
times, as long as there are multiple 
entries in your view history.

Forward Alt + Right 
Arrow

Takes you to the next view in the history 
of your view selections. You can 
continue until you reach the view you 
were at when you first clicked Back.

Start Page Takes you to the Start Page.

Help Takes you to the Help view.

Table 1-4: Edit Menu Commands (cont.)

Command Shortcut Toolbar Button Description
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Build Menu
Below is a listing of the Build menu commands, as well as associated keyboard 
shortcuts and icons.

Tools Menu
Below is a listing of the Tools menu commands, as well as associated icons.

Project 
Assistant

Displays the Project Assistant.

Table 1-7: Build Menu Commands

Command Shortcut Toolbar Button Description

Build 
SingleImage

F7 Builds your release.

Stop Build Ctrl + Break Cancels the current build process.

Run 
SingleImage

Ctrl + F5 Enables you to run your completed 
installation without leaving InstallShield.

Uninstall 
SingleImage

Uninstalls the most recently run release.

Table 1-8: Tools Menu Commands

Command Toolbar Button Description

Open Release 
Folder

Launches Windows Explorer, and opens the release folder.

Check for 
Updates

Launches the Update Service dialog box if the product is 
registered with the Update Service.

Customize Displays the Customize dialog box.

Options Displays the Options dialog box.

Table 1-6: Go Menu Commands (cont.)

Command Shortcut Toolbar Button Description
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Help Menu
Below is a listing of the Help menu commands.

Start Page
The InstallShield Start Page provides quick access to product information, to recently 
opened projects, and to InstallShield resources.

Project Tasks
Click a project task to quickly create a new project, open an existing project, or 
browse to one of the sample projects included with the InstallShield installation.

Help Topics
Frequently accessed help topics are listed in this section. To access the entire 
InstallShield Help Library from the Start Page, press F1 or click the Help Library link 
in the Resources section.

(Recently Opened Projects)
The section in the middle of the Start Page lists your most recently accessed projects 
and the dates on which they were last modified.

Table 1-9: Help Menu Commands

Command Description

Contents Displays the Contents tab of the InstallShield Help Library.

Index Displays the Index tab of the InstallShield Help Library.

Search Displays the Search tab of the InstallShield Help Library.

Support 
Central

Displays the InstallShield Support Central on the Web.

InstallShield 
Community

Displays the InstallShield Community on the Web.

Release Notes Displays InstallShield release notes.

Feedback Connects to the Macrovision Web site to enable you to provide feedback.

Macrovision on 
the Web

Connects to the Macrovision Web site.

About 
InstallShield

Displays the About InstallShield dialog box, where you can find version 
information and register InstallShield.
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Beneath the project list are links to the top Knowledge Base articles and information 
on upcoming InstallShield training courses and seminars.

Resources
The Resources section contains a number of links to connect you to helpful 
InstallShield information and Macrovision’s responsive customer support.

Contact Us
To provide feedback about InstallShield or join our Customer Experience 
Improvement Program, click one of the links listed here.

Project Assistant
InstallShield includes a Project Assistant to help you quickly and easily build a basic 
installation project. The Project Assistant provides a framework of installation project 
tasks to guide you through the project creation process and provides pertinent 
information along the way.

When you create a new installation project, the Project Assistant view automatically 
opens. Information that you enter in the Project Assistant is saved directly to the 
underlying project file.

The following topics provide information to help you start creating your installation 
through the Project Assistant:
• Specifying General Application Information
• Specifying Operating System Requirements for Your Application
• Specifying the Features for Your Application
• Specifying Application Files for Your Installation
• Defining Your Application Shortcuts
• Updating the Registry
• Specifying End-User Dialogs for Your Installation
• Building Your Installation
• After Completing the Project Assistant: Next Steps
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Output Window
The Output window opens across the bottom of InstallShield when you build your 
project. It also provides information about your project during project conversion. The 
following tabs appear in the Output window:

Import REG File Wizard
The Import REG File Wizard enables you to import existing registry data (.reg) into 
your InstallShield project. This registry data is added to the target system’s registry 
during the installation.

The following panels are associated with the Import REG File Wizard:
• Welcome
• Import Registry File
• Import Conflict Options
• Import Progress

Welcome Panel
The Import REG File Wizard enables you to import existing registry data (.reg) into 
your InstallShield project. This registry data is added to the target system’s registry 
during the installation.

Click Next to begin importing your .reg file.

NOTE InstallShield can import .reg files created by exporting in Regedit only, or files that follow that 
exact format. Additionally, InstallShield does not support multiline registry values.

Table 1-10: Tabs on the Output Window

Tab Description

Output Stores distribution output information and displays build output; a link to the log 
file saved as a text file will be active.

Tasks Provides descriptions of any errors and warnings that occur when you build 
your project; each error or warning code displayed will link to an article in the 
Knowledge Base.

http://www.macrovision.com/support/index.shtml
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Import Registry File Panel
In the Import Registry File panel, you can specify the .reg file that you want to import.

Import Conflict Options Panel
Because your installation may already contain registry data that could conflict with 
information stored within the .reg file you are importing, you can select how you want 
to handle any conflicts.

Import Progress Panel
The Import Progress panel displays the import progress of the .reg file. Click Cancel 
to stop the import or wait until the wizard finishes importing your .reg file and click 
Finish to return to InstallShield.

Dialog Boxes
Each of the dialog boxes available in InstallShield is described in this section:
• Additional Properties
• Create Application Path
• Digitally Sign Setup 

Table 1-11: Settings on the Import Registry File Panel

Property Description

Registry File Enter the path to the .reg file you want to import, or click the Browse button to 
navigate to this file.

InstallShield can import .reg files created by exporting in Regedit only, or 
files that follow that exact format. Additionally, InstallShield does not 
support multiline registry values.

Table 1-12: Settings on the Import Conflict Options Panel

Property Description

Overwrite the 
registry data

Select this option if you want data stored within the .reg file you are importing 
to overwrite any conflicting data already present in your installation project.

Do not 
overwrite the 
registry data

Select this option if you want to retain the data already present in your 
installation project when a conflict arises during the import progress. All 
nonconflicting registry data are still imported.
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• Edit Data File Properties
• File Properties
• Folder Properties
• New Project
• Options
• Properties
• Save As
• Set INSTALLDIR

Additional Properties Dialog Box
Use the Additional Properties dialog box to set properties such as the product GUID, 
your company’s support Web address, and your company’s support telephone 
number.

Create Application Path Dialog Box
If you install an application’s .dll files into a directory other than the application’s 
directory, use the Create Application Path dialog box to set the appropriate application 
path to include the .dll directory during installation. The application path registry key 

Table 1-13: Options on the Additional Properties Dialog Box

Option Description

Specify your 
company’s 
support web 
address

Type the uniform resource locator (URL) that you would like your users to visit 
for technical support. This URL is displayed as a hyperlink in the Support 
Information dialog of Add or Remove Programs in Control Panel.

Specify your 
company’s 
support 
telephone 
number

Type the technical support phone number that your users can call to get help 
with your product. This information is displayed in the Support Information 
dialog of Add or Remove Programs in Control Panel.

Specify your 
application 
product GUID

This box contains a string GUID that uniquely identifies this product release. 
Since the product GUID uniquely identifies this release, changing the product 
code after you have already distributed your release is not recommended. The 
product code GUID should be uniquely generated for each version of your 
product.

Click the Generate New Product GUID button to use a new GUID for your 
product code.
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contains data that Windows uses as a private search path for the specified 
application’s .dll files.

Digitally Sign Setup Data Dialog Box
The Digitally Sign Setup dialog box is displayed when you click Digitally Sign Setup 
on the Build Installation page of the Project Assistant. This dialog box enables you to 
assure your end users that the code within your application has not been modified or 
corrupted since publication.

When building a release on a Windows 2000 machine, SP4 must be installed in order 
for you to digitally sign the application.

Dialog Box Options

Digitally sign setup.exe
Select the Digitally sign setup.exe check box to digitally sign Setup.exe.

The other boxes on this dialog box are enabled when you select the Digitally sign 
setup.exe option.

Certificate Url
Type a fully qualified URL—for example, http://www.macrovision.com. This URL 
is used in your digital certificate to link to a location that you would like end users to 
visit in order to learn more about your product, organization, or company.

Software Publishing Credentials File
Specify the location of your .spc file provided by a certification authority. You can 
type the path to the file in this box or click the folder button to browse to the file 
location.

Table 1-14: Options on the Create Application Path Dialog Box

Option Description

Select the .exe file that you want to create 
an App for, or type in the name of the .exe 
file.

Type the name of the executable (.exe) file in 
your installation for which you want to create an 
application path, or click the ellipsis button (...) 
to browse to find the file.

Add the directories containing your .dll files 
using the Add button

This box contains a list of one or more 
directories that contains the .dll files for your 
project. Click the Add button to add a directory 
to this list.
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Corresponding Private Key File
Specify the location of your private key (.pvk) file provided by a certification 
authority. You can type the path to the file in this box or click the folder button to 
browse to the file location.

Password
If you would like to pass the password for the .pvk file to ISCmdBld.exe to digitally 
sign your application while building the release from the command line, type the 
password in this box. InstallShield encrypts this password and stores it in your project 
(.ise) file.

If you do not specify a password in this box but you are digitally signing the release 
while building it from the command line, you will need to manually enter the 
password when you are prompted each time you build the release from the command 
line.

Edit Data Dialog Box
The Edit Data dialog box enables you to edit the registry data within your installation 
project. To launch this dialog box, right-click a value on the Application Registry 
page and select Modify.

File Properties Dialog Box
The File Properties dialog box lets you specify the properties for a file when it is 
installed onto the target system. To launch this dialog box, right-click a file on the 
Application Files page and select Properties.

Table 1-15: Options on the Edit Data Dialog Box

Option Description

Value Name The value name is read-only in this dialog box. To change the name of a value, 
close this dialog box, select the value you want to rename, and press F2.

Value Data Type the data for this registry value as you want it to appear on the target 
machine.

Table 1-16: Options on the File Properties Dialog Box

Option Description

Location This box specifies the file directory.

Size This box tells you the size of the file in bytes.
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Version This box is the version string for a versioned file. This box is blank for non-
versioned files.

Override 
system 
attributes

Clear this check box to install this file using the same system properties that 
are currently set for this file on the development system. Select this check box 
to override any of the following properties:

• Read-only—Select the check box for this property if you want the file to 
be read-only when it is installed.

• System—Select the check box for this property if you want the file to be 
installed as a system file.

• Hidden—Select the check box for this property if you want the file to be 
hidden when it is installed.

Self Register If the file supports self-registration, you can select this check box. Clear this 
check box if you do not want the selected file to be registered on the target 
machine.

Permanent Select this check box if you want this file to permanently remain on the target 
system. Permanent files are not removed during an uninstallation.

Shared Select this check box to instruct the Compact installer to reference count, or 
“refcount,” this file.

When a file is marked as shared, the installer creates a refcount if one does not 
exist or increments it if it does. The refcount is stored under the following 
registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Shared
DLLs

This count is decremented when the file is uninstalled.

Always 
Overwrite

If you select this check box, the file—if it exists on the target system—is 
always overwritten, regardless of the file version. Clear this check box 
(recommended) if you want standard versioning rules to be used:

• Versioned files—In all cases, the file with the highest version is 
maintained, even if the file already on the target machine has a higher 
version than the one being installed. Additionally, a file of any version is 
maintained over unversioned files.

• File language—All other things being equal, the file that is the same 
language as the installation is maintained over different language versions 
of the file. The only exception to this rule applies to multiple language files. 
Files with multiple languages are maintained over single language versions 
of a file.

• Date—If the modified date of a file already present on the target machine 
is later than the creation date of that file, the file is not overwritten. This 
rule protects user preference files from being wiped out during an upgrade 
or reinstallation.

Table 1-16: Options on the File Properties Dialog Box (cont.)

Option Description
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Folder Properties Dialog Box
Use the Properties dialog box to view the information about a folder that will be 
installed on the target machine. This dialog box is displayed when you right-click a 
folder on the Application Files page and then click Properties.

Type
Specifies the type of folder.

Location
Specifies the directory identifier for the selected folder, as well as the location to 
which the folder will be installed on the target machine.

Size
Specifies the size of the folder’s contents.

Contains
Specifies the number of files and subfolders within the selected folder.

New Project Dialog Box
This dialog box is displayed when you create a new project in InstallShield. In the 
dialog box, you can select a project type, name your project, and provide a location for 
the project’s files. Once you entered the necessary project information in the New 
Project dialog box and clicked OK, the Project Assistant is opens to help you create 
your project.

Table 1-17: Options on the New Project Dialog Box

Option Description

Project Name Type a name for your project in this field.

Project 
Language

With the Compact project, you can create your installation in English only. This 
means that all of the end-user dialogs shown during the installation process 
appear in English. Other languages are supported in other editions of 
InstallShield. For more information, visit http://www.macrovision.com.

Location Type a location or click Browse to navigate to a project location. To change the 
default project location displayed, change the Project Location path, which is 
located on the File Locations tab of the Options dialog box.

http://www.macrovision.com/
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Options Dialog Box
The Options dialog box enables you to specify preferences for creating projects and 
working in InstallShield.

TASK To open the Options dialog box:

On the Tools menu, click Options.

The Options dialog box is organized into multiple task-related tabs.
• General
• File Locations
• Preferences
• Quality
• Updates
• .NET (not applicable to Compact projects)
• Files ViewFile Extensions ViewConfigure Trialware (not applicable to Compact 

projects)
• Merge Module Options (not applicable to Compact projects)

Properties Dialog Box
The Properties dialog box enables you to set several properties that determine if and 
how a feature or subfeature is listed in the Select Features end user dialog. It also lets 
you set any operating system requirements for a feature or subfeature.

NOTE You cannot create conditions for the Always Install feature.

The Properties dialog box is organized into two tabs. Click one of the links to learn 
about the corresponding tab.
• General
• Operating System

Create the 
project in 
Project Name 
subfolder

Select this option if you want InstallShield to create a subfolder with your 
project’s name in your Projects location.

Table 1-17: Options on the New Project Dialog Box (cont.)

Option Description
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General Tab
The General tab on the Properties dialog box is where you set several properties for a 
feature or subfeature in your installation.

NOTE You cannot create conditions for the Always Install feature.

Operating System Tab
You may need to install a different version of a feature depending on the operating 
system of the target system. With the Operating System tab on the Properties dialog 
box, you can specify for which operating systems a feature is intended.

Select the All Operating Systems check box if the feature can be installed to supported 
platform. This check box is selected by default. Clear this check box to select the 
specific operating systems that the feature targets.

NOTE You cannot create conditions for the Always Install feature.

Table 1-18: Options on the General Tab

Option Description

Enter the description you 
want to display about the 
feature to your end user

Type the description that should be displayed when an end user 
clicks a feature in the Select Features dialog.

This Feature is Required to be 
installed

If you want to require that end users install this feature, select 
this check box; end users are not able to deselect this feature 
in the Select Features dialog, and the feature is installed.

If you clear this check box, end users have the ability to select 
or deselect this feature for installation.

Make this feature Visible to 
the end user

If you want the feature to be listed in the Select Features dialog, 
select this check box.

If you clear this check box, the feature is not listed in the Select 
Features dialog. Although the end user cannot choose whether 
to install an invisible feature, this property has no effect on 
whether the feature is installed.



Chapter 1: Compact Projects
Reference

InstallShield Express Edition Compact Project User Guide 37

How InstallShield Creates the Operating System Feature 
Conditions
When you select specific operating systems, you are essentially excluding operating 
systems that do not support the feature.

For example, if you select only the check box for the latest Windows operating 
system, InstallShield creates a feature condition to exclude the operating systems that 
you did not select. With this type of feature condition, future versions of Windows 
operating systems are supported automatically because they are not excluded in the 
feature condition.

If you select each of Windows 9x check boxes, the feature condition that InstallShield 
creates excludes all Windows NT operating systems. In this scenario, any future 
Windows NT operating systems are not supported, but all future Windows 9x 
operating systems are supported.

Save As Dialog Box
On the File menu, click Save As to open the Save As dialog box. This lets you save a 
copy of the open project as a new project with a different name and location.

File Name
Type the name of the file in this box.

Save as type
This list enables you to specify the type of file you are saving.

Set INSTALLDIR Dialog Box
Use the Set INSTALLDIR dialog box to browse to a directory, create a new directory, 
rename a directory, or delete a directory. When you click OK, the default installation 
directory is set to the selected directory.

Destination Directories
This box lists all of the currently available destination directories. You can select, 
create, rename, or delete directories in this box.
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Specifying a Default Installation Directory

TASK To specify a default installation directory:

1. Click a directory to select it.
2. Click OK.

Creating a New Directory

TASK To create a new directory:

1. In the Destination Directories box, select a directory or Destination Computer, 
and press INSERT. A directory is created beneath the selected item.

2. Type the directory name.

Renaming a Directory

TASK To rename a directory:

1. Select a directory or Destination Computer and press F2, or right-click and 
select Rename.

2. Type the new directory name. Note that you cannot rename predefined directories.

Deleting a Directory

TASK To delete a directory:

Select a directory and press DELETE, or right-click and click Delete. Note that 
you cannot delete predefined directories.

NOTE When you delete a directory, any subdirectories beneath the selected directory are also deleted.

End-User Dialogs
This section serves as a reference to all end-user dialogs available for your 
installation. The following topics are covered:
• Welcome Dialog
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• License Agreement Dialog
• Customer Information Dialog
• Choose Destination Location Dialog
• Select Features Dialog
• Ready to Install Dialog
• Setup Status Dialog
• Setup Complete Success Dialog

Welcome Dialog
The Welcome dialog is the first dialog displayed when your installation is launched. 
This dialog serves two purposes: the first is to let users know that your installation is 
running. To achieve this, the company name that you enter on the Application 
Information page is displayed with a welcome message. The second purpose of the 
Welcome dialog is to display copyright information for your installation.

Figure 1-1: Example of a Welcome Dialog

License Agreement Dialog
The License Agreement dialog displays your end-user license agreement (EULA). 
When this dialog is displayed, a user must accept your license agreement before 
continuing with the installation.

Although the License Agreement dialog is not required, it is selected by default. The 
Installation Interview page is where you specify whether this end-user dialog should 
be included in your installation. It is also where you identify the path to your license 
agreement file, which must be a rich text file (.rtf).
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Figure 1-2: Example of a License Agreement Dialog

Customer Information Dialog
The Customer Information dialog enables you to gather information such as user 
name and company name from your users.

Although the Customer Information dialog is not required, it is selected by default. 
The Installation Interview page is where you specify whether this end-user dialog 
should be included in your installation.

Figure 1-3: Example of a Customer Information Dialog
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Choose Destination Location Dialog
The Choose Destination Location dialog displays the target destination for your 
installation and can provide functionality for changing that location.

The Choose Destination Location dialog is optional and is not selected by default. The 
Installation Interview page is where you specify whether this end-user dialog should 
be included in your installation.

Figure 1-4: Example of a Choose Destination Location Dialog

Select Features Dialog
The Select Features dialog is displayed to enable users to choose which features they 
want to install. This dialog is displayed if you have more than one feature in your 
installation and at least one of the features (not including the Always Install Feature) 
meets all of the following criteria:
• The feature is set to be visible to the end user.
• The feature is not required to be installed.
• The operating system of the target machine meets any operating system 

requirements that have been set for that feature.
• To set whether a feature is listed in the Select Features dialog, and to specify the 

description associated with a feature, see Specifying the Features for Your 
Application.
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Figure 1-5: Example of a Select Features Dialog

Ready to Install Dialog
The Ready to Install dialog is the last dialog that occurs before file transfer takes 
place. Therefore, it is the end user’s last chance to change installation options or 
cancel before the InstallShield Wizard begins modifying the system.

Figure 1-6: Example of a Ready to Install Dialog

Setup Status Dialog
The Setup Status dialog displays all of the actions—such as file transfer—taking place 
during your installation.
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Figure 1-7: Example of a Setup Status Dialog

Setup Complete Success Dialog
When your installation successfully executes, it displays the Setup Complete Success 
dialog. This dialog informs your users of a successful installation. It also gives them 
the opportunity to launch your application or your readme file, if you specified in your 
project that these options should be included. This dialog is required.

The Installation Interview page is where you specify whether this end-user dialog 
should include the options for launching your application and/or your readme file.

Figure 1-8: Example of a Setup Complete Success Dialog
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Errors and Warnings
This section contains information about errors you may encounter during the build 
process or while running the installation. Also included are tips on how to eliminate 
the errors.

Build Errors and Warnings
The table below provides troubleshooting tips for each build error and warning. Note 
that %s is the string place holder, and %x is the number place holder formatting the 
number in hexadecimal.

Table 1-19: Build Errors and Warnings

Error Description Troubleshooting Tips

-32000 Build canceled by the user This error occurs only when the build is terminated during 
the build process.

-20008 Unable to perform build. 
Inadequate space on %s 
drive

For a project to build successfully, sufficient free disk 
space (about twice the size of all files in the installation 
project) is required. However, the Setup.exe file for you 
project could not be built because the build machine does 
not have enough disk space. To resolve this error, try 
freeing up disk space on the build machine. For specific 
steps on how to free up disk space and clean the 
temporary directory, see Consumer Central articles How 
Do I Increase Hard Disk Space on My Computer? and 
Clean the Temp Directory.

-20007 Failed to stream %s into 
the media (setup.exe).

For a project to build successfully, sufficient free disk 
space (about twice the size of all files in the installation 
project) is required. However, the Setup.exe file for you 
project could not be built because the build machine does 
not have enough disk space. To resolve this error, try 
freeing up disk space on the build machine. For specific 
steps on how to free up disk space and clean the 
temporary directory, see Consumer Central articles How 
Do I Increase Hard Disk Space on My Computer? and 
Clean the Temp Directory.

-20006 Failed to seek to end of 
setup stub.

This error occurs if the build failed to seek to the end of 
the installation stub, a necessary first step in packing the 
headers and .cab files into Setup.exe.

http://consumer.installshield.com/kb.asp?id=Q108409
http://consumer.installshield.com/kb.asp?id=Q108409
http://consumer.installshield.com/kb.asp?id=Q108334
http://consumer.installshield.com/kb.asp?id=Q108409
http://consumer.installshield.com/kb.asp?id=Q108409
http://consumer.installshield.com/kb.asp?id=Q108334
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-20005 Failed to open the 
installation stub.

This error occurs if the build failed to open 
SetupCE.exe and thus was not able to pack the 
headers and .cab files into Setup.exe. If the 
SetupCE.exe file is read-only, this error occurs. To 
resolve this error:

1. Using Windows Explorer, find the SetupCE.exe 
file. It is in the following location:
InstallShield Program 
Folder\Redist\Language 
Independent\i386

2. Right-click the SetupCE.exe file and select 
Properties.

3. Clear the Read-only check box.

-20004 Required engine file 
SetupCE.exe is missing.

The engine file SetupCE.exe is missing from InstallShield 
Program Folder\Redist\Language Independent\i386. To 
restore this file to the proper location, try to repair 
InstallShield: In Add or Remove Programs in the Control 
Panel, select the InstallShield application, and then click 
Change. The InstallShield Wizard opens; use this wizard to 
perform a repair of InstallShield.

-20003 Failed to create file %s. 
Last Error: %x

This error may occur when the headers (header.xml or 
fActions.xml) are being created. To resolve this error, 
ensure that you have write permission to the project 
location. The default project location is the My 
InstallShield Express Projects folder at the root level of 
your hard drive; for example, C:\My InstallShield 
Express Projects.

-20002 Exception %x occurred. 
Exception Message: %s

An exception occurred while headers (header.xml or 
fActions.xml) were being generated. This error can occur 
for many reasons.

To resolve this error, try to rebuild the installation. If this 
error still occurs, try restarting InstallShield. If the 
problem persists, try to repair InstallShield: In Add or 
Remove Programs in the Control Panel, select the 
InstallShield application, and then click Change. The 
InstallShield Wizard opens; use this wizard to perform a 
repair of InstallShield.

Table 1-19: Build Errors and Warnings (cont.)

Error Description Troubleshooting Tips
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-20001 A file included in the build 
is not found. File: %s

File not found error. The error message lists the name of 
the file that was missing. This error occurs during a build 
if any of the files being packed into the installation media 
is missing on the system. It also occurs if any file that 
goes into the Res.cab file—such as Eula.rtf or 
_isresce.dll—is missing. The _isresce.dll file is stored in 
InstallShield Program Folder\Redist\0409\i386. To resolve 
this error:

• If _isresce.dll is missing, try to repair 
InstallShield: In Add or Remove Programs in the 
Control Panel, select the InstallShield application, 
and then click Change. The InstallShield Wizard 
opens; use this wizard to perform a repair of 
InstallShield.

• If Eula.rtf is missing, open the Installation 
Interview page and note the path indicated for the 
EULA file. Use Windows Explorer to verify that the 
EULA file is in the specified location.

• If a different file is missing, open the Application Files 
page. Ensure that all of the files included are in the 
locations specified.

-1014 Cannot rename a 
directory.

Windows Explorer or a DOS prompt may be pointing to a 
subfolder of the release output folder (Disk1) or to the 
Interm folder, locking it. Change the current directory. 
Close any open files in the Disk1 folder.

-1013 The specified file is being 
used by another program.

Close the application that is currently using the file and 
rerun the build process.

-1009 Insufficient disk space or 
the target drive cannot be 
located.

Increase disk space on the build target, or select a new 
target for the build. If the target drive cannot be located, 
select a new target, or ensure permissions are set 
correctly for the target drive.

Table 1-19: Build Errors and Warnings (cont.)

Error Description Troubleshooting Tips
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